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About the Graphics Editor

SECTION 1 Graphics Editor

1-1

1-2

SECTION 1
Graphics Editor

This chapter describes the Graphics Editor and the various tools and controls
available. It also provides instructions for using these tools and controls and is
supported with suitable screen displays.

About the Graphics Editor

Palette Bar

The Graphics Editor enables a variety of objects to be created on a page.
Supported objects are:

» Graphical objects.
» Control objects.
* ActiveX objects.

Graphical objects are geometric shapes, for example ellipses and polygons,
but also include Text objects. Control objects allow information to be displayed
and entered in clear way through the use of Wizards. Examples of control
objects include buttons and Trend Graphs. ActiveX objects or controls are
from sources external to CX-Supervisor.

Refer to chapter 3, Objects for further information regarding control objects
and bitmap objects. Refer to chapter 4 for further information on ActiveX
Objects.

The tools are contained on the Control Bar and the Palette Bar. The palettes
allow all similar types of tool to be kept together. The various tools and tool
bars are discussed in the following chapters. Status and help information is
presented in a Status Bar located at the bottom of the main CX-Supervisor
window.

The Palette Bar contains the tools to apply colour, style and transparency
options to the graphic objects placed on CX-Supervisor pages.

Fill Colour Transparency
|
Palette | [=]
()] —— -[o%
, !
I
Line ! Text Colour Line Style

The Palette can be removed or re-displayed at any time by selecting Palette
from the View menu.

A tick next to the name indicates the Palette is currently displayed. CX-
Supervisor saves the settings when it is exited and restores them when it is
next run.

Each of the buttons on the palette is discussed in more detail in the following
paragraphs.
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Palette Bar SECTION 1 Graphics Editor

1-2-1 Line/Text Colour
To create an object with a particular line, border or text colour: before selecting
the object's tool from the Graphic Object bar, first select the colour by clicking
one of the colour buttons to drop down the colour picker. This approach
applies to Soild and Gradient colours.

Palette B
-] ——— ~ (0% -
Solid Color | Gradient Color
Standard Colors
HEN ENEERER

-I“Illlllllll
System Colors: [.Elack -

Color Palette | Custom Colors

Note: It is not strictly necessary to select a colour for an object before creating it,

however if no colour selection is made, the object retains the same colour as
the last object.

To apply a colour to a previously created object, select the object on the page
and select a colour (Solid or Gradient) using the same method as before.

Note: Colour may only be applied to some graphic objects. It cannot be applied to
embedded objects or bitmap graphics.

1-2-2  Fill Colour
To create an object with a particular fill colour: before selecting the object's tool
from the Graphic Object bar, first select the colour by clicking one of the colour
buttons to drop down the colour picker. This approach applies to Solid,
Gradient, Hatched or Texture colours

18



Palette Bar

SECTION 1 Graphics Editor

Note:

Note:

Palette [=]

- — 0%~

Solid Color | Gradient Color | Hatched | Texture |
Standard Colors
HER ENEEEN
-I“IIlIllllII
System Colors: [ < Select System Color > =
Caolor Palette | Custom Colors

It is not strictly necessary to select a colour for an object before creating it,
however if no colour selection is made, the object retains the same colour as
the last object.

To apply a colour to a previously created object, select the object on the page
and select the Solid, Gradient, Hatchedor Texture colour using the same
method as before.

Colour may only be applied to some graphic objects. It cannot be applied to
embedded objects or bitmap graphics.

1-2-3 Custom Colours

It is possible to create custom colours by clicking on the ‘Custom Colors’ tab
shown below. Up to 28 custom colours can be created and they will be saved
with the CX-Supervisor project. The 28 user-defined custom colours will
appear on the Solid, Gradient, Hatched and Texture tabs, making it easy to
use them once defined. Transparency can be directly applied to colours using
the ‘Alpha’ (A) value shown in the image below below. This will be in it's raw
value of 0 to 255.
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Graphic Object bar

SECTION 1 Graphics Editor

1-2-4 Line Style

1-2-5 Transparency

1-3

20

Note:

Note:

Palette (=]

-0 —— -[o% -

Solid Color | Gradient Color | Hatched | Texture |

v | 255 q
Color Palette | Custom Colors |

To create an object with a particular line style: before selecting the object from
the Tool Palette, first select the line style by clicking on line style button to drop
down the Line Style picker. The ‘No Line’ option can be used to remove the
outline (border) from objects.

It is not strictly necessary to select a line style for an object before creating it,
however if no line style selection is made, the object retains the default style of
thin solid.

To apply a line style to a previously created object, select the object on the
page and click on the appropriate line in the Line Style Palette.

Line styles may only be applied to some graphic objects. They cannot be
applied to text, embedded objects, controls or bitmap graphics.

The ‘Transparency’ option can be used to control the opacity of objects (i.e.
whether they are completely solid, transparent or somewhere in between. If an
object has a transparency value of 0% then it will be completely solid (i.e. it will
not be possible to see the objects beneath it). A value of 100% will make the
object fully transparent (i.e. it will not be possible to see the object itself but
the objects beneath it will be fully visible. A value of 50% would make the
object semi-transparent (i.e. The object’s colour will appear faded and it will be
possible to see the objects beneath it although their colours will appear
darker). The editing rules are consistent with the previous items.

Graphic Object bar

The Graphic Object bar contains the tools to create the graphic objects, which
can be placed on pages within CX-Supervisor.



Control Bar

SECTION 1 Graphics Editor

14 Control Bar

fﬂﬁ\--olmowﬂw4$mmia%m&u@a
[ & g

Selection Graphics Objects

In general terms, the operation of the Graphic Object bar is simple. With a
page active the Graphic Object bar is active, and operation involves merely
clicking on the desired tool to select it, and then clicking and dragging to the
appropriate point in the page. This is not the case with the text, polygon or
polyline tools, however the operation of these tools is fully discussed in
chapter 3, Objects.

Moving the mouse pointer over any of the tools causes CX-Supervisor to
display a tooltip to describe the tool.

By default, the cursor returns to Selection mode (an arrow) after drawing an
object. If you would prefer it to remain in its current state, clear the Return to
select mode checkbox in the Editing Preferences dialog box, which is found on
the CX-Supervisor file menu.

For further details concerning the tools contained within the Graphic Object
bar refer to chapter 3, Objects.

CX-Supervisor provides a Control Bar containing formatting and object
manipulation tools. The Control Bar can be activated or deactivated from the
View menu. To activate the Control Bar, select Control Bar from the View
menu; CX-Supervisor places a check mark next to it signifying its active
status. To deactivate it, repeat the procedure (the check mark is removed),
and the Control Bar is no longer displayed. The various tools on the control
bar allow the properties of objects to be modified.

A control may be activated with more than one object selected to change a
particular attribute of all of the selected objects, e.g. when all graphical objects
on a page are selected and the Rotate button is pushed in and the desired
angle specified, all selected objects are rotated.

An illustration of the Control Bar is as follows:

| [Gauge_1 | =il L’ |z ﬂl
The Control Bar may vary slightly from this according to the display resolution

currently in use - the number of buttons displayed depends on the available
space - at higher resolutions more buttons are displayed.

The Control Bar can be removed from the display at any time by selecting
Control Bar from the View menu.

A tick next to the name indicates that it is currently displayed. CX-Supervisor
saves the settings when it is exited and restores them when it is next run.

The specific operation of the controls on the Control Bar is described in the
following paragraphs.

1-4-1 Object Identification

When an object is created, CX-Supervisor gives it a unique identifier. This
identifier consists of the object type and a sequential number (starting at 1).
For example, a text object could have an identifier of TEXT_1; a polygon
object could have an identifier of POLYGON_3 etc. The Object Identification
field displays a list of all current objects on a page.
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1-4-2 Raise Up One

The identification of an object can be changed by clicking on the entry in the
Object Identification control, typing over the entry and pressing <Return>. A
confirmation box is provided to double check the operation, click the OK
button to proceed with the name change or the Cancel button to abort the
operation.

It can at times be difficult to select a particular object if it is mostly obscured by
other graphic objects. The Object Identification control allows an object to be
selected by simply selecting its name from the presented list. click the arrow
button to display the list and select the desired object. On selection the object
is highlighted.

The following illustration shows the Object Identification control in de-selected
state:

‘ |Pulygnn_1 j |

The following illustration shows the Object Identification control in selected
state:

Polygon_1]| il
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Text_1

The EI button allows an object which forms part of an overlapping group of
objects to be moved nearer the top of the group, one layer at a time. With an
object selected, clicking the button once moves the object up one layer. This
continues until the object is at the top. Clicking the button with the object at the
top of a group has no effect.

The following example illustrates the state of a group of two objects before and
after clicking the Raise Up One button with the black round rectangle selected:

1-4-3 Lower Down One
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The EI button allows an object which forms part of an overlapping group of
objects to be moved nearer the bottom of the group, one layer at a time. With
an object selected, clicking the button once moves the object down one layer.
This continues until the object is at the bottom. Clicking the button with the
object at the bottom of a group has no effect.

The following example illustrates the state of a group of two objects before and
after clicking the Lower Down One button with the grey polygon selected:
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1-4-4 Rotate

The EI button allows graphical and bitmap objects to be rotated. With an
object selected, clicking the button once opens the Rotate dialog box. Set the
desired angle and click the OK button to rotate the object.

Anghe: oK, |
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The following example illustrates the state of an object before and after
clicking the Rotate button and defining a 10 rotation with the object selected:
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1-4-5 Horizontal Mirror

The ﬁl button allows graphical and bitmap objects to be mirrored in the
horizontal plane. With an object selected, clicking the button once "flips" the
object producing a vertical mirror image.

The following example illustrates the state of an object before and after
clicking the Mirror Horizontal button with the object selected:
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1-4-6 Vertical Mirror

The El button allows graphical and bitmap objects to be mirrored in the
vertical plane. With an object selected, clicking the button once "flips" the
object producing a vertical mirror image.

The following example illustrates the state of an object before and after
clicking the Mirror Vertical button with the object selected:
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1-4-7 Transparency On/Off

1-4-71

1-5
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The ﬂl button changes an object from solid to outline and from outline to
solid. With an object selected, click the button and the object toggles from
solid to outline (or vice versa).

The following example illustrates the state of an object before and after
clicking the Transparency button with the object selected:

NOTE: CX-Supervisor 3.4 introduced a new ‘Transparency’ dropdown control,
in the Palette Bar, that allows the transparency of objects to be set between
0% and 100% in increments of 10%. As a result, the ‘Transparency’ toggle
button (described in this section) will now toggle between fully transparent (i.e.
100%) and the current transparency value set for the object, which could be
anything from 90% (almost fully transparent) to 0% (completely solid).

Set Transparent Colour

Status Bar

The J| button allows the optional transparent colour of picture objects with
.bmp and .gif file types to be set.

By clicking the Set Transparent Colour button and then clicking on a colour on
the image you can select the colour that will appear transparent.

The following example illustrates the effect of using the transparency colour in
conjunction with the transparency mode to remove the unwanted parts of the
image:

CX-Supervisor provides help and status information in a Status Bar located at
the bottom of the main window.

The Status Bar has two main active areas: the Help Message area, and the
Cursor Co ordinates area.

The Help Message area is used by CX-Supervisor to display helpful
information concerning menu selections and controls. It is located at the left
hand end of the Status Bar, and can display messages similar to the following:

4l

|Choose fil pattern from palette
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1-6

1-6-1

Text Bar

Font Name

The Cursor Co ordinates area provides position information for the current
location of the mouse pointer as it tracks around the active page within the CX-
Supervisor window. If an object on a page is selected, the status area displays
the co-ordinates of the location of that object. An example of the system status
area is shown below:

of
N o
The first two display panels show the current x and y co ordinates of the
mouse pointer within the currently active page. As the mouse pointer leaves
the confines of a page and moves into the client area of the main CX-
Supervisor window, the last recorded co ordinates are held in these panels.

If an object is clicked on, all four panels are used by CX-Supervisor to display
the co-ordinates of that object, as follows:

¥ o

"[153 133 [189 [148
x y Width Height

The first two panels contain the distance of the top left corner of the object
from the top left of the page in pixels. The second two panels show the extent
of the object in pixels.

An illustration of the CX-Supervisor Text Bar is as follows:

-] Blz]e|[= ==

{Times New Roman «| |10

The Font Name field contains a list of fonts which are available on the host
version of Windows. The list is presented in alphabetical order, and only
details typeface families. This does not include bold or italic variants as this
attribute is set by using the appropriate button.

The following illustration shows the control in de-selected state:

|Times Mew Roman |£I

The following illustration shows the control in selected state:

Times New Foman é]
Symbol +
Symbol
Times
Times New Roman_

Tms nllll'l

Willow

Wingdings

Woodtype Dnaments 2
ZapfChancery
ZapfDingbats

The Font Name field displays the current font attribute for the selected
object(s). To change the font for a block of text, highlight it and click either: the
down arrow adjacent to the edit part of the control, or into the edit part of the
control itself, for the Font Name field. The control then displays a list of

available fonts, from which the desired typeface may be selected.

If more than one block of text is selected with each having different font
attributes, the edit part of the control is empty. However, selecting a font from
the supplied list still sets the font attribute for all the selected group of text
blocks.

*l ]
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Fonts and font families are printer dependent, therefore changing the printer
within the Printer Setup dialog box (accessed from the File menu) changes the
fonts which are available within the Font Name field.

1-6-2 Font Size
The Font Size field contains a list of point sizes available on the host version of
Windows for the selected font. The list is presented in numerical order.

The following illustration shows the control in de-selected state:
[0 ]|

The following illustration shows the control in selected state:
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Either click the cursor into the editable area of the control and enter a new
point size, or click the down arrow and select a new point size from the
presented list.
The control displays the current point size for the selected block of text. If more
than one block of text is selected having different point sizes, the edit part of
the control is empty. However, selecting a font from the supplied list (or typing
in a new point size) still sets the point size for all the selected blocks of text.

1-6-3 Text Bold On/Off

1-6-4

1-6-5

1-6-6
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The 1' button allows any selected text objects to be set to bold when the Text
Bold button is pushed in, or normal when the Text Bold button is released. Text
Bold only applies to text, block text, and to text on buttons, other controls and
graphics cannot be emboldened.

Text Italic On/Off

The il button allows any selected text object(s) to be set to italic when the
Text Italic button is pushed in, or normal when the Text Italic button is released.
Text Italic only applies to text, block text, and to text on buttons, other controls
and graphics cannot be italicised.

Text Underline On/Off

The EI button allows any selected text object(s) to be set to underline when
the Text Underline button is pushed in, or normal when the Text Underline
button is released. Text Underline only applies to text, block text, and to text on
buttons, other controls and graphics cannot be underlined.

Text Left Aligned
The EI Aligned button aligns any selected text object(s) to the left edge of the
bounding box. Text Left Justified only applies to text, block text, and to text
on buttons, other controls and graphics cannot be left justified.
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1-6-7

1-6-8

Text Centred

The El button aligns any selected text object(s) to the centre of the bounding
box. Text Centre Justified only applies to text, block text, and to text on
buttons, other controls and graphics cannot be centre justified.

Text Right Aligned

Grid

Note:

The El button aligns any selected text object(s) to the right edge of the
bounding box. Text Right Justified only applies to text, block text, and to text
on buttons, other controls and graphics cannot be right justified.

The use of the grid may be helpful in drawing and aligning the objects on the
screen. Select the button to enable the grid.

The grid settings are available by selecting Grid from the View menu. All the
available grid sizes are shown along with a Snap to Grid option which forces
graphical objects selected by the user to align according to the current grid
setting.

The buttons can be customised to remove or add favourite functions.

Tip of the Day

On startup, a Tip of the Day dialog box opens. All tips can be reviewed using
the Next and Previous buttons. This dialog box can be turned off, or turned
back on from the Help menu.
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SECTION 2
Points

This chapter describes CX-Supervisor points and the procedures associated
with the creation, amendment and removal of points using the Points Editing
facility. The application of external sources to points is also described.

2-1 What is a Point?

A point is a variable used internally by CX-Supervisor. All points within CX-
Supervisor have a name, group and type associated with them.

CX-Supervisor provides a set of pre-defined System ($) Points, which are
detailed later in this chapter.

2-2 About the Point Editor

The Point Editor allows the viewing, creating, modifying and removing of
points from the points database.

Note: System Points cannot be modified.
To open the Point Editor dialog box, click the button.
An example of the Point Editor dialog box is as follows:
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The typeface of the editor can be amended by selecting Preferences from the
File menu. This is especially useful when printing.

Note: To select a range of points, click on a point to mark the start of the range and
click again with the <Shift> key down to mark the end.

Note: To individually select more than one point, click while holding the <Ctrl> key
down.
Note: The short-cut keyboard combinations for Cut, Copy and Paste operations are

valid within the Point Editor. Highlight one or more points and type <Ctrl>+X to
cut or <Ctrl>+C to copy; use <Ctrl>+V to paste. Since the cut and copy
operations store the information in the Windows Clipboard, points may be
pasted to another CX-Supervisor application. See also Chapter 2 Quick
creation of many points.

Note: If the I/O type ends with ' ' and a number, it is an array point with the shown
number of elements.

2-3  Viewing Points in the Point Editor

The Point Editor view of the points database can be tailored by filtering or
sorting the available points.
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2-3-1

Filtering the Points in the View by Group

Points are separated into groups. To select a group, pick an entry from the
Group field.

All points can be displayed by selecting <All Groups> from this list.

2-3-2 Filtering the Points in the View by Point Type

A selection of points can be displayed based on the point type. Selection of the
All Points button displays points of all types.

The Boolean Points button only displays points of a Boolean type. The Integer
Points button, the Real Points button and Text Points button, once selected,
react in the same way.

2-3-3 Sorting the Points in the View by I/O Type

Points can also be filtered by 1/O type. Respectively, these buttons display All
Points, Memory Points, Input Points, Output Points or Input/Output Points.

=8| &

2-3-4  Sorting the Points in the View

Individual listed points are sorted, based on a designated field type: name,
type, input/output type or description. By clicking on the Name button, the
points are sorted alphanumerically by name.

The Type button, the I/O Type button, the Address button and Description
button, once selected, react in the same way. In the previous Point Editor
example the list is sorted by Name.

The widths of the point fields can be widened or narrowed as required using
the mouse to drag the column boundaries:

A double click the text boundaries causes the column to autosize.

2-3-5 Changing the Viewing Mode

Click the button to configure which columns 